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Flig.3-89: Comparison: Build properties object 1/object 2, one difference identi-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.
Select the cross E to prevent (undo) merging.

Comparison: Network Variable Lists, Receiver End

The comparison applies to global variable lists used as network variables on
the receiver end that were created as independent objects of an application.

= These lists are created automatically and remain current within
the project.

In this way, the comparison is only executed as a check for differ-
ences.

When comparing network variable lists, the content display is XML based.
Modification (merging) is not possible.
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Fig.3-90: Comparison. Nefwork variable lists on the receiver end
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The next/previous difference is selected with ¥ or
The next tab shows the build properties.

"_ Comparison
-SnnEa
| ojectz.
Falz
Extemal mnplementation | Falze Falze
Allow system call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE
| 4 Makch{es) || 1 DiFFerence(s)|
Compare all Sub-elements | Cloze | Help |
Y
Fig.3-91. Comparison: Build properties object 1/object 2, one difference ident-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.

Comparison: Programs, Function Blocks, Functions...

Comparison: ST

The comparison applies to the following objects:

* PROGRAM, FUNCTION_BLOCK, FUNCTION
® ACTION, TRANSITION

¢ METHOD, PROPERTY with GET and SET

The objects named can be declared and implemented in the IEC program-
ming language editors available in the system.

Comparisons of the declaration and objects which have been implemented in
structured text are text based.
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=
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Fig.3-92: Comparison. PROGRAM in ST, declaration and implementation

Merging is possible in the declaration and in the implementation.
o

The next/previous difference is selected with + or

ﬁ Accept Block can be used to accept the coplete highlighted text block.

J-' .
Accept Single can be used to accept text line by line. In this case, only

the possible result of the merge is displayed first. Clicking the button again
resets the display.

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
The next tab shows the build properties.

" Comparison [0 x] I
“m Buid properies | |
Element Dfject | Otyjoct
Evchude from boild Fabs | Fales
Evteand tuplemicriafion | Faiee { False
Al systemn call Falze Falze
Alwaaps link Falze Falze
Camnpiler definitions Test_War= TRUE
| 4 Matchies) || 1 Difference(s)|
Compare all Sub-elements | Close | Help |

2|

Fig.3-93: Comparison: Build properties object 1/object 2, one difference identi-

fied and marked in red
If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com
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Select the hammer to merge.

Select the cross E to prevent (undo) merging.

Objects that have been implemented as function block diagram are com-
pared graphically.
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Fig.3-94. Comparison: PROGRAM in FBD, declaration and implementation
Merging is possible in the declaration and in the implementation.
The next tab shows the build properties.

™ Comparison

-SAnEaN
Objects
False
Falze
Allowy spsten call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE
| 4 Makch{es) || 1 DiFFerence(s)|
Compare all Sub-elements | Cloze | Help |

4

Flig.3-95: Comparison. Build properties object 1/object 2, one difference identi-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.
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Comparison: |IL
not possible here.

POUs implemented in the instruction list are compared as XML. Merging is

Pcompareon T g |
G-OjEnEan
w Diata | uld propeti |
+ | Artept Blork Agcanl Sirglk
|3 _active .t (Project) | it _active (Project) _
= <Element Type="TLStatement'> <Element Type=ILStatement'> _4_[
+- «Operator Type="String:= <0perator Type="3tring'= x
<Prefix Type='String/ > <Prefix Type='String' = :
= «rperand Type="Operand'> £ioperand Type="0perand > J
= «Operand Type='String'= <Operand Type='String'> !
| -<Type Type="String'> <Type Type="String> .
P . =Comment Type="String'/ > <Comment Type='"String' = LI
Compare options: Ignore whitespace: O | |Ignure comments: OFF | |Ignure properkies: OFFl
Compare statistics: 0 additionis) | |D deletionis) | |3 change(s)|
Close | Help |
4
Fig.3-96. Comparison: Action in instruction list, implementation
The next tab shows the build properties.
Ry compason i
-BOgEag
Element ; Otject 2
Exchudefomboid ~  Fabs Falwe
Extesnal implemenitshon | Falis Falsz
Al systemn call Falze Falze
Alwaaps link Falze Falze
Camnpiler definitions Test_War= TRUE
| 4 Matchies) || 1 Difference(s)|
Compare all Sub-elements | Close | Help |
2

Fig.3-97: Comparison: Build properties object 1/object 2, one difference identi-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.

Objects that have been structured by means of SFC (sequential function
chart) are compared graphically. Merging is only possible in the declaration.

Comparison; SFC
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Fig.3-98: Comparison: FUNCTION_BLOCK with SFC structure, declaration and
Implementation
The next tab shows the build properties.
Fucomporion |
B EaN
oYy
False
Extemna implementation | Falie Falze
Allow systen call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE
| 4 Makch{es) || 1 DiFFerence(s)|
Compare all Sub-elements | Cloze | Help |
A
Flig.3-99: Comparison: Build properties object 1/object 2, one difference ident-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
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Fig.3-100: Comparison. POU "Direct subelements”

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.

". Comparison Results B
TR
Left Elements [Project] Right Elements [Froject]
SEQLENCE_1 SEQUEMCE
Init_active Init_active
Irit_active_1 Iriit_active_1
=g | Greenl_active Greenl_active
Greenz_active Greend_active
Switchl_active Switchl_active
SwitchZ_active SwitchZ_active
Fig.3-101: Comparison. POU with all subelements with the filter option "All ele-

ments”, "Different elements”, "ldentical elemenis”

Comparison: CFC  POUs implemented in the instruction list are compared as XML. Merging is
not possible here.
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Fig.3-102: Comparison. PROGRAM in CFC, declarafion and implementation
The next tab shows the build properties.

-
= LOMPENson

Dbjeet 1 Objects

Exchidefiombuld | Foke Fakie
Evisma mplemenitation | Fale Fale
Allowy spsten call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE
| 4 Makch{es) || 1 DiFFerence(s)|

Cloze | Help |
Y

Compare all Sub-elements |

Fig.3-103: Comparison: Build properties object 1/object 2, one difference ident-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
Comparison: Interfaces, Interface Methods, Interface Properties

When comparing interfaces, interface methods or interface properties, the
content display is XML based.

Modification (merging) is not possible.

t.

The next/previous difference is selected with ¥ or
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Fig.3-104: Comparison. Interfaces, interface methods, interface properties
The next tab shows the build properties.

|

® Comiparison

E-gpnigag

Element | Dbectd | Dbjectz
Evchdefomtuid | Fale Fates
Extemnal impiemeritation | Fale Falsg
Al systemn call Falze Falze
Alwaaps link Falze Falze
Camnpiler definitions Test_War= TRUE
| 4 Matchies) || 1 Difference(s)|

Help |

Close |
4|

Compare all Sub-elements |

Fig.3-105: Comparison: Build properties object 1/object 2, one difference identi-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.

Comparison: Library Manager

When comparing Library Managers, the content is listed in tabular form. Ac-
ceptance is possible line-by-line.
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Fig.3-106: Comparison: Library Manager, here ML_Robot added info the project
The next/previous difference is selected with ¥ or '&.

? Accept Block can be used to accept the coplete highlighted text block.

v Accept Single can be used to accept text line by line. In this case, only
the possible result of the merge is displayed first. Clicking the button again
resets the display.

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
The next tab shows the build properties.

--f_ ompanson !F‘m
-OHREan

R I

Element | Objoct Objoct 2
Evchude iombuld | Fake Fake
External implementaiion | Fale Fake
Allow systen call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE

| 4 Makch{es) || 1 DiFFerence(s)|

Compare all Sub-elements | Cloze | Help |

4

Fig.3-107: Comparison: Build properties object 1/object 2, one difference ident-
fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):
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Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.

When comparing "library info", the content display is XML based. Modification
(merging) is not possible.

[Pacomponson T g |
E-apaEaon
= Data |Bw1ﬁmmﬁml
+ | o Accept Slocle ~ Aoespt Smpts
| Froject Information (Profect Praject Tnformation (File)
= <Propetties Type="Hashtable'= <Properties Type="Hashtable'> -
= 2Element > <Element =
* <key Type='String> <Key Type='String'>
= =¥alie Type="String's <¥alue Type="String'>
- [Test lib 02 Test_lib 01
+ - <Elgment> <Element >
+- <Element: -<Element >
+  £Elements ZElement >
+ <Element: o
W cGetCompanyGUID Types'Guid = <GatCampanyGUID Type="Guid >
b <Gt THBGLID Types'Guid s <GRtTHBGUID Types=Guid > =
wodoner e Whitespane G0 gnere coents: OFF lignece rapsiles: OFF '
|Compare statistics: | 7 addition(s) 2 delstianfs} 10 changs(s)
oese | Hep |
4
Fig.3-108: Comparison. Library Info; library enabled with version number
10.06.0.1
= The terms "Project Information" and "Library Info" designate the

same element.

The next tab shows the build properties.

A Comparison =1 I

E-8|f0ME

Element Oegect 1 Ohject 2
Erclude from build False False
External implementation | Falze Falge
Al systemn call Falze Falze
Alwaaps link Falze Falze

Camnpiler definitions Test_War= TRUE

| 4 Matchies) || 1 Difference(s)|

| Close | Help |
4|

Compare all Sub-elements

Comparison: Build properties object 1/object 2, one difference identi-

Fig.3-109:
fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).
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If the checkmark appears, it can be used to prepare the acceptance

(merging):

Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.

When comparing data servers, the content display is XML based. Modifica-

tion (merging) is not possible.
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Fig.3-110:

The next/previous difference is selected with ¥ or

Comparison.: Data server

t.

The next tab shows the build properties.

Socomporion =

o-goaEan

o 3
Falsa
Fale
Allow systen call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE
| 4 Makch{es) || 1 DiFFerence(s)|
Compare all Sub-elements | Cloze | Help |

4

Fig.3-111:

Comparison. Build properties object 1/object 2, one difference identi-
fied and marked in red
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If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.

- Comparison !Ii[ E
B M0 ME

[ ] Datal Build properties

Posi... DataServer [Project] Posi... DataServer [Project]
2 DataSource_1
@ 1 DataSource 1 DataSource

| 0 Matchiesy " 2 Differencels) |

Compare all Sub-elements I Cloze Help |

Fig.3-112: Comparison. Data server, Direct subelements

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.

".. Comparison Results x|
CIE
Left Elements [Project] Right Elements [Project]
D ataServer [rataServer
@ D ataSource_1
@ DataSource DataS ource
Fig.3-113: Comparison results: Data server

Comparison: Data Source (Data Server)

When comparing data sources, the content display is XML based. Modifica-
tion (merging) is not possible.
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Fig.3-114: Comparison. DataSources +
The next/previous difference is selected with ¥ or .
The next tab shows the build properties.
-. | ompanson !F‘m
-gPpnEan
® Buld properties |
Element | Objoct Objact &
Evchude iombuld | Fake Fake
Extemd implemeniation | Fake Fale
Allow systen call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE
| 4 Makch{es) || 1 DiFFerence(s)|
Compare all Sub-elements | Cloze | Help |
Vi
Fig.3-115: Comparison: Build properties object 1/object 2, one difference ident-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If t

he checkmark appears, it can be used to prepare the acceptance

(merging):

Select the hammer to merge.
Select the cross E to prevent (undo) merging.

Comparison: Symbol Configuration

When comparing symbol configurations, the content display is XML based.
Modification (merging) is not possible.

Comparison: Visualization Man

ager

When comparing visualization managers, the content display is XML based.
Modification (merging) is not possible.

The next tab shows the build properties.
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Facomparison —————————— mEE|
G-gpaEag

| Element Object 2
Evohude from boid ’. Fabs Falze
Estesna implemenitshion | Falis Fals=
Alflovs systemn call Falze: Falze
Alwaaps link Falze Falze
Camnpiler definitions Test_War= TRUE

| 4 Matchies) || 1 Difference(s)|

Compare all Sub-elements

Close

Help

2|

Fig.3-116: Comparison: Build properties object 1/object 2, one difference identi-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.

When comparing visualizations, the content display is XML based. Modifica-
tion (merging) is not possible.

The next tab shows the build properties.

Facomparison —————————— mEE|
G-gpaEag

| Element ; Object 2
Evohude from boid ’. Fabs Falze
Estesna implemenitshion | Falis Fals=
Al systemn call Falze Falze
Alwaaps link Falze Falze
Camnpiler definitions Test_War= TRUE

| 4 Matchies) || 1 Difference(s)|

Compare all Sub-elements

Close

Help

2|

Fig.3-117:
fied and marked in red

Comparison: Build properties object 1/object 2, one difference identi-

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):
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Select the hammer to merge.
Select the cross E to prevent (undo) merging.
When comparing text lists, the content display is XML based. Modification

(merging) is not possible.
The next tab shows the build properties.

e COmpatison

G-8/HM

BEan

: B Buddproperties

Exchodeflombuild | Falee Fake
Extemna imglementation | Falze Fal=
Allow systen call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE

| 4 Makch{es) || 1 DiFFerence(s)|

Compare all Sub-elements | Cloze | Help |

4

Fig.3-118: Comparison: Build properties object 1/object 2, one difference ident-
fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.
Select the cross E to prevent (undo) merging.

When comparing image pools, the content display is XML based. Modifica-
tion (merging) is not possible.

Comparison: Recipe Manager

When comparing recipe managers, the content display is XML based. Modifi-
cation (merging) is not possible.
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= J™, Comparison [ o]
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S ) Genendl module folder

%Eﬁ”ﬁ;ﬁm ® 03 | Buid propestes| m Dirent sofyolsmess)
= [ Miet + | & AccaptBlagk, ~ Accegt Sings
E %Sﬂ L% et [ezspturverates (Project) i Gra
= %naasew = =iMGuids Type="LanguageModelGuidHelper'> lMGuids Type=1angusoeMadelGuidHelper'>
MicvarGlobal = <NamesandGuids Type="Hashtable's <NamesAndGuids Type='Hashtable'>
Liservariobal = <Element> <Element>
% Library Managsr = <Key Type='"String'> <Ky Type="string'>
=] MotiorProg [PAG] [RECTPEMANAGEMENTINITFE_INIT RECTF NTINIT
(Z] PicProg (FRG] # <Value Type=Guid > <Valie Type="Guid's
= R?me'w% ' 4 <Flements> <Elament>.
g @, Recipes.1 arsane wi competis '_‘ﬂfFI:nJ:er:'tt\}\'DﬁaH‘JE GFF
G 8 Tk st ey T )
£ DataSeverT s B
o 3 MotionT ask Compare dlSubmerts | | 'Bisa || Heb |
o 22 PleTask 4
Fig.3-119: Comparison. Recipe Manager
The next/previous difference is selected with ¥ or '&.
The next tab shows the build properties.
-DIAD|GaR
Elment Tobectt bjetz.
Exchade from besid | Fabes Fake
Ewhemnal impiementstion | Faks Falze
Al systemn call Falze Falze
Alwaaps link Falze Falze
Camnpiler definitions Test_War= TRUE
| 4 Matchies) || 1 Difference(s)|
Compare all Sub-elements | Close | Help |
Z|

Fig.3-120: Comparison: Build properties object 1/object 2, one difference identi-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross ﬂ to prevent (undo) merging.

"_ Comparison !E[ E
-BM0ME
] Datal Build propertie:
Posi.. FRezepturverwalter [Froject] Posi.. Rezepturverwalter [Froject]
2 Fiecipes
Q 1 Fecipes 1 Fecipes
2 Differenceis)
Compare all Sub-elements | Cloze Help |
4

Fig.3-121:

Comparison. Recipe manager, Direct subelements
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If the assignment in the columns of the two objects differs, L can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.

". Comparison Results B

FEEIE

I Left Elements [Project] Right Elements [Project]
Fiezepturvenualter Fiezepturvenualter

Q Recipes

Q Fiecipes Fiecipes

Fig.3-122: Comparison results: Recjpe Manager

Comparison: Recipe Definition

When comparing recipe managers, the content display is XML based. Modifi-
cation (merging) is not possible.

The next tab shows the build properties.

-.f_ ompanson !l;lm
-goaEan
® Buld properties |

‘Element | Object 1 Object 2

Evchude iombuld | Fake False

Extend implementation | False Fale

Allow systen call Falze Falze

Always link Falze Falze

Compiler definitionz Test_\ar=TRUE

| 4 Makch{es) || 1 DiFFerence(s)|

Compare all Sub-elements | Cloze | Help |

4

Fig.3-123: Comparison: Build properties object 1/object 2, one difference ident-
fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.

Comparison: Devices (Onboard 1/O, Inline 1/O, Field Busses, ...)

The comparison applies to the devices that are associated with the respec-
tive control (onboard I/O, Inline 1/O, field busses). Since these differ from con-
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Menu ltems trol type to control type, the following comparison results have to be seen as
examples.

In principle, it is tried to provide a familiar environment at comparison with re-
gard to the input and to enable merging based on the comparison.

Onboard 1/O;
Eixaeck ko == comparieon ___________________________________________________________ EEH
=[] Prog_Compare_03 N 1 -
12 Gl module older ﬂ— ‘ 00 ‘ L
=l Mict u Daa |y
- ) Logie I il properties | .
& 1M Mokori | & acoont Bk~ Aesapt Singhd
e %;;ﬁ:’t‘“w ‘Onboard 10 (Profect) | Onboard_1_0 (Project)
| Dibosid 10 (Onboed 1/0] Hame: Type | Value | vansble Address | Name Type Variable: Addres|
14 Iniine: 140 (Inine 1/0) = Onboardin %180 || = Onboardin %180
. Prafibus/M [Profibuz DP Master] 11 BooL 1200 #11 (BOGL IR0.0
B Nicht_verwendet (Micht verwendet] f 21 |BoGl ApplicationMotionProgbUnBoatd eb 1 |%I:0.1 ozt ool T0.L
i sercos # 14 [BocL ApplicationMotionProg bOnBuard_en 2 (%1402 # 14 |BooL ot
Bl 24 B0l bnfoard_e0_3 {%Ix0.3 @24 BonL EACTE
& 0 Logic @11 BOOL LA, 4 @11 BOGL Application.MotionProg.binBoard_=0_4 %1004
B 11 Molion #21 |poal 0.5 Lo#z1 mhoL ApplicationMotionProabDnBoard e0 5 %1405
e %;‘Zﬁ:‘mw %14 podl %G # 14 poOL bOnBoard_e0_& IH0G
T # 24 |pooL (I20.7 # 24 BO0L TR0 T
‘Onboard 170 {Onboard /0] L " B " i
7 Inline 10 Inline 10 * "% Onboardou %GB0 + "9 Onboardo... HOR0
mn ProfbusM [Prafibus DOP Master) u| [esaiinas _,,I ol || _,I
7" g::lt_s;lwsndsl (Nigtt ververices] Compare optians: (e whitewpoce: S0 {Tarre comments | G | g pr \Jmm;r.\ T
Zompai e statistics: 0 additianis) |0 delstion(s)! & chiange(s)
(Class Help
F

Fig.3-124: Comparison: Onboard l/O:
The next/previous difference is selected with ¥ or t.

3; Accept Block can be used to accept the coplete highlighted text block.

-’I" .

Accept Single can be used to accept text line by line. In this case, only
the possible result of the merge is displayed first. Clicking the button again
resets the display.

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
The next tab shows the build properties.

Pcomparion |
-BOnEaa
Falee
Falze
Ao gystem call Falze Falze
Ailways link Falze Falze
Compiler definitions Test_ar=TRUE
| 4 Matchies) || 1 Difference(s)|
Compare all Sub-elements | Cloge | Help |
Vi

Fig.3-125: Comparison: Build properties object 1/object 2, one difference identi-
fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).
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If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.

The comparison shows the Inline cycle counters and diagnostic data tabs be-
longing to the Inline I/O objects. Merging is not intended.

H

=] Lg Frai_Compars_073

.-l.uln|m||50l| HF] E I
120 General module folder b ‘ D H ﬂ L'.I L!
- [E Mt el ) (i =H o
Bl Lo Data | Buid propatties| m Diect |
M hdotion | & Ancepk Bloch fezept Snale
7 l*:.:t IIEEolC::?Dlogy ]-Inﬂ‘n\%:;g__ﬂ) (Project) 'I-Inﬁn&j__z__‘a:[ﬂmgt}
_ Onboard /0 (Gnboard 1/0) Mame Type | wale | varsble | ac | Name: Type | wvalue | warable | &
B ﬂj HMIQ’BUWJ‘JGI ; # @ Inline-Cycle-Counter + @ Inline-Cycle-Counter
" [ R_IELIL_24.DI_8 (A8 1L 24 DI &) # @ Diagrdeis B P Diagniss
|3j H__IE_IL_ | DO_8 [RB 1L 2400 8)
“mr Profibus/M [Prafibus DP Master] .
8 Nicht_verwendet Not Used] 4l ) _ B WHET _ e
I sercos ; [Tommhe whitespince: O] Toante conosnrs: OFF | Idnas s btapmties: OFF
Mic2 0 addition(s) 0 dele 16 ehafiael
s o) 0 dobton) [0 chaneels) _
i Compsre ol Subrslements | Bese || Hep |
1| Technology B
& By Robat 4|
<[] Onboard /0 (Onboard /0]
= (2] e 1220 i 1463)
! L-Tj A_IB_IL 24 DI_8(RB.IL24 D1 8)

Fig.3-126: Comparison: Infine I/O: Inline cycle counters and diagnostic data tabs
The next tab shows the build properties.

- -
= LOmparison

Exclude trom buld Fake False
Externd implementation | False Fale
Allow systen call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE
| 4 Makch{es) || 1 DiFFerence(s)|
Compare all Sub-elements | Cloze | Help |
Y

Fig.3-127: Comparison: Build properties object 1/object 2, one difference ident-

fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
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Menu Items -Llunp.lrl‘;ull HHE
E-anmamon
Data | Build properties | Sierments |
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5 1} ALBLIL 24 ) d 1 FoIE_ L 24 0] 8
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Compare 3l Subvelements | Close | Hep |
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Fig.3-128: Comparison: Infine I/O: Direct subelements
If the assignment in the columns of the two objects differs, can be used
to select the next difference ( for the previous difference).
If the checkmark appears, it can be used to prepare the acceptance
(merging):
Select the hammer to merge.
Select the cross E to prevent (undo) merging.
". Comparison Results =]
= JIE]
Lett Elements [Froject] Right Elements [Project]
[ nline_I_0O0 Inline__O
@ re_L_24 D8 R_IB_IL_24_DI_8
[ R IBIL 24 DO 8
Fig.3-129: Comparison results. Inline I/0: All subelements
Inline I/O modules  If the Inline I/O modules under "Direct subelements" and "Comparison re-
sults" have identical names and are marked in red, this is an indication of dif-
ferent assignments:
&3 Project Expigrer. e |
ik B-BEaEn
= %mf;ﬂi_ugc = Data | Biid prometis |
%— ™ Maion # % | fccestBoch, < AcceptSngle
I o 71 21 D16 roect) R 18124 13 Proec)
& Onbosrd 1/0 [Drbosd 1/0) MNiame Typs | vakue | Varisble % Mame T Waloe: | Variable: 7o Md@??ﬁ
= ] Inine /0 (ine L70] = % Input %185 = Inputn \\'%mu
J RIB.IL 24 DI 8(RIBIL 24DI8) # 1.1{BOCL i % 1.1 BOOL -mxn{
4] R_IB_IL_24 DO_8[RJB IL24D0 B # 2.1 {800 ING, L # 2.1 [BooL Application.MotionProg.bnBoard_en_1 %50, 1
‘= Frofibus/b [Profibis DP Master) # 3.1 [EOOL BING.Z # 3.1 [Bool il
B Nicht veiventick ot Ll s # a1 (Bo0L %IvE3 # 4.1 [BooL binfine e1_3 Sl
1 M sercos # 5.1 |BOCL Application,MotionProgblnhine el 4 5154 @ 5.1 [BoaL L34
= @Mu . # 6.1 BOCL %lX5.5 @ 6.1 [BOOL A e
f %ﬂ Lngc # 7.1 BOOGL binlinc_c1 & UINE.B # 7.1 [BOCL WIRDE
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Fig.3-130: Comparison: Infine I/O modules

The different addresses with identical location of the modules in the Project
Explorer indicate an address shift.

The next/previous difference is selected with ¥ or '&.
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? Accept Block can be used to accept the coplete highlighted text block.

#I" .

Accept Sindle can be used to accept text line by line. In this case, only
the possible result of the merge is displayed first. Clicking the button again
resets the display.

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
The next tab shows the build properties.

- -
= LOmparison

Exchude from buld Fake False
Externa implementation | False Fale
Allow systen call Falze Falze
Always link Falze Falze
Compiler definitionz Test_\ar=TRUE

| 4 Makch{es) || 1 DiFFerence(s)|

Compare all Sub-elements | Cloze | Help |

4

Fig.3-131: Comparison: Build properties object 1/object 2, one difference ident-
fied and marked in red

If the assignment in the columns of the two objects differs, can be used

to select the next difference ( for the previous difference).

If the checkmark appears, it can be used to prepare the acceptance
(merging):

Select the hammer to merge.

Select the cross E to prevent (undo) merging.
3.6.2 Simulation

The command is available in the context menu of the relevant control and is
used to switch on and off the simulation mode of the programming system.

In the simulation mode, the active application can be started and debugged
on a "simulated target device". As such a simulated device is always integra-
ted into the programming system, no real target device is needed to test the
online behavior of an application. If the command is called from the context
menu if an application is selected in the Project Explorer, login is carried out
with this selected application even if it is not set as "active application".
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Fig.3-132: Context menu, simulation switch-on
No communication settings need to be entered for the simulated device.

Following a successful login, the corresponding online commands can be
used to test the application.

&1 Project Explorer

P.Ii:.F'.mgll.Jl.';‘é_lE:onlmI: Logic: Applica.tinn] - X

[ Simuation
0 General rodule Talder Bee_Contral Application,PleProg
chﬂtfor'gtif' Exprassion. |/ Type TE | reparedvabie. | Comment =]
im0k i
b UservarGlobal 5
5 Library tanager i i !
|E] PleFiog [FRG)
[ ] # Surmbol configuration A (*fk1s 13 & placekolder. Plesse roplace (ke placeholder with your owm logic.®) -~
# [4 Tak Configuration = boDumnyEALSE = bolunuyFALSE OR bolhmnyFALSE: FETIRN]
| Onboard /0 [Orboard 1/0)
] Infine 140 (Inline 1/0]
o Profibug/M [Profibus DP Master]
B

Simulation mode iz activel
More infarmation cam be found in the 'Statuz page’ of the editor.

Fig.3-133: Control in the simulation mode
To switch off the simulation mode, first log off from the control and then call
the"Simulation" command again. The tick in front of the command disap-

pears, the entry of the target device in the Project Explorer is no longer
shown in italics and it can be thus logged into the real target device.

3.6.3 IndraLogic Project Versions

From IndraWorks 12VRS, a PLC project contains a project version. Using
this version code, compatible PLC projects can be generated for all known
releases (V02, V04, V06, ...) of an IndraWorks version.

If an older project version is identified while a project is opened, the following
dialog appears:

Theptojdt is contained ina previous praject version-and has to be converted to the current format, Subsequantly, the project cannot be opened
~ / anmymore with the previous project version| Tio-you want, to convert the project now?

Fig.3-134: Dialog: Project in old project version detected

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com
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Using the dialog, an accidental conversion of the PLC project can be preven-
ted.

If the project is available in a 12VRS release version, it can be edited in all
later IndraWorks releases of this version without conversion and saved in a
release-compatible form. The project can be explicitly saved in a later release
version. For this purpose, the "IndralLogic project version" command is used
which is by default executed under Tools > IndraLogic project version :

ﬂ Indralogic Project Yersions

Indralogic project version

[12v02 |
12408
ok | Cancel |

Fig.3-135: Dialog: Indral ogic project version
Using the dialog, the project can be converted in a later release version. Con-
version into an older format is not possible as here, data would be lost.

A newly created project is automatically always generated in the latest re-
lease version. As long as no device has been inserted into this project, the
project can be converted to an older project release using the <IndralLogic
Project Version> command described above.

I By using new features of the current Indraworks version that are
not available in the project version, the project version can be up-
dated automatically.

These automatic changes can be corrected using the "Undo"
command.

3.6.4 Library Repository - Commands
Library Repository - Commands, General

Library Repository...

"Library management" provides access to the "Library Repository ..." com-
mand for opening the dialog with the same name.

By default, the command is located in the "Tools" menu. If required, the menu
structure can be changed using the dialog in IndraWorks » Tools » Custom-
ize » Commands »> Library Manager.

Further information

e  Using libraries, see page 83.

Icon: ﬁl

This command opens the Library Repository dialog, which can also be
opened from the Library manager editor window, page 367,.

A library repository is a storage location for libraries that were installed on the
local system in order to be included in IndraLogic projects.
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Menu ltems = A library project "*.library" located in a library repository cannot be
opened from the repository for editing or for viewing in the pro-
gramming system.

To achieve this, the library has to be added to the library manag-
er.

{%iil Library Repository

Location: ISystem j Edit Lacations.. . |

(C:iDokurnente und Einstellungenial

— Installed libraries: Install... |
Company:  |ialle Fi hd
I I( & Firmen) J Uninstall |
+. *= (Sonstige) -
+- 2= ppplication Category
ER Indralogic

Mame of library
IndraMoti LC

=,
3

Base

S IL_Parameterghannel  Spsten
=) ToDrwCIFRERpernetIPDCIA - Spsfen

3
“ Company
+ -+ IoDryCIFXRfofinetDCIA  Spsfan
+ =1 ML_Base o Sprfem Warsion
== ML_Base_MLC_L2S 5y§_fgn.--""" Find... |
[Re 11200 &— |
@ 11.4.0.0 = Details... |

¥ Group by category Dependencies.. . |

Library Profiles. .. | Close

:

Fig.3-136: Main dialog "Library Repository”
The dialog displays the currently defined storage locations (repositories) and
the libraries installed there.

This dialog can be used to add new repositories, to modify or remove them
and libraries can be installed or uninstalled here.

A list of all of the currently installed libraries for the currently selected storage
location, a directory on the local system in which the library files are located,
and for the company that is currently set, is displayed. This list displays the
respective name (title), version and company for a library as entered in the
library information in the library file.

If the Group according to category option is selected, the list is grouped ac-
cording to library categories. The category names appear as nodes that can
be expanded or reduced via click. The respective libraries appear below the
categories and the respective versions appear below the libraries. If grouping
is not performed by category, the libraries are listed alphabetically according
to company.

The categories are defined by external description files ( *.libcat.xml).
The individual buttons are described in the following:

e  Edit: Library Repositories, page 187

e [nstall, Uninstall: Installing and uninstalling libraries, page 188

. Details: Further information on libraries, page 189,

¢ Dependencies: Display of the libraries used, page 189,

e Library profiles: Display of the library profiles, page 190, ordered ac-
cording to placeholder name or compiler version.
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Library repositories

Creating a new repository

Menu ltems

One or more repositories can be used for managing libraries. All of the cur-
rently defined repositories are in the selection list next to Storage location: By
default the "System" repository is always created during the installation of
IndraLogic.

To change the path or name of a repository, use the Edit... buttons to open
the Edit repositories dialog:

[ {i Edit Repository Locations

Repositaties (ibraries are searched in that order):

Lacation Marne add...
CPokumente wid Sinstalngenial | (Managad { drarias |5y5'rm

Close

o s

Fig.3-137: "Edit Repository” dialog

The currently defined storage locations are listed in the repository window.
Later, a search for a library is made in the sequence listed here. To change
the sequence, use the Move up and Move down buttons to move the current-
ly selected entry.

Note that the storage location <All companies> lists the libraries in all of the
currently defined repositories. No installation or uninstallation can be per-
formed in this display.

To create a new repository, use the Add button. The Repository Location dia-
log opens, where the path of the new repository has to be entered in the Lo-

cation field. Use the [:] button to search for a suitable directory or create
one.

Q Attention: The selected directory has to be empty!

In the Name field enter a representative name for the repository, e.g. Libra-
ries for system xy.

To edit an existing repository, select the entry in the Repositories dialog and
use the Edit button to open the Repository Locations dialog, where in this
case, the current information for location and name are already entered and
can be modified.
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Menu Items
Repository Location
Location: |C:\Debkuments und Enstefungen|Repos 2
Hams: iF';:—Dnsitcw_E
or Zancel J
Fig.3-138: Sef sforage location and name for repository dialog
= 1. Only empty directories can be used for a new repository.

2. The "System" repository cannot be edited, which is indicated
by the italic font used for this entry.

Deleting a repository  If a repository in the list is selected and <Remove> is clicked, a query ap-
pears asking if only the entry is to be removed from the list of repositories or
if the directory with the library files is also to be deleted from the file system.

Installing and uninstalling libraries  Only one library that is installed on the local system in a library repository can
be included in a project using the library manager.

A prerequisite for the installation is that the library file has to contain a title
and version information in its library information, page 371,; information on
category and company is optional.

To install a library, select the repository in the "Library Repository" dialog to
which the library is to be added and click the <Install...> button.

The "Select Library" dialog opens, where it can be searched for the library
file.

e By default, the filter is set for "libraries" that contain the appropriate li-
brary information and have the default extension *.library.

®  The filter can also be set for "compiled libraries" that contain the appro-
priate library information and have the default extension *.compiled-li-
brary.

®  The filter can also be set to "IndralLogic libraries (before 2.x)" to find li-
braries with old formats and with the extension *.lib or to
o "All files".

Select the desired library file and close the dialog. The library is added to the
list of installed libraries in the library repository dialog.

If you try to install a library that cannot be installed, since it does not have the
required library information (title, version), the following error message ap-
pears:

The library entered is not a managed library. (Reason: No library information
could be found.)

To uninstall a library, select it from the list of installed libraries in the library
repository dialog and press <Uninstall>.

Searchin library  Dialog to search libraries in the specified storage location. This search is
used to find function blocks and the related libraries. Apart from the search
string for the function block, the placeholders "*" and "?" can be used.
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Details...

Dependencies...
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Find what: I*Base j Find |

{You can cee * and 7 as wittant,)

™ Match case

™ Include comments inta search

— Result:

= -+ ¥YisuElemBase, 3.3.1.20 (System) ;I
=0 TyisuManagerBase
W GetInternCammandManagerBase [IvisuManagerBase]
M GetFrameManagerBase [IvisuManagerBase]
= [FrameElementBase
|E] visu_FbFileDialogRiecipeCommandBase
|4 GetFrameManagerBase [Visu_Fb¥isuManager]
= TFrameManagerBase

|E] visuFbRectElemBase =
1| ) |
242 occurrences in 91 libraries Details, ., |
O I Cancel | 4

Fig.3-139: "Find library” dialog

Pay attention to upper and lower cases: This search takes the case of the
search string into account

Integrating comments into the search: Not only the name of the function block
but also the comment is searched

When a library is selected from the list of installed libraries - ensure that the
line selected contains the version - it button opens a dialog that displays the
following details: Title, version, company, size, created (date), changed
(date), edited (date of most recent access), properties.

This information origins from the library information, page 371, in the library
file.

Y |
General: Eropertias: 1
TRie: ML Base SLE 125 ey | Nalue | -
::::M :_‘z'm‘ i .ﬂ_«uthur Bosch Rexroth Electric Drives and Cantrals GmbH j
Sizet 50,89 KB (564,112 bytes) Company Fystem
Crestad::  Wednesday, March 162011 B:5%:13 AM DefaultNamespace ML _Base
Changed:  Tuesday, February 01, 2011 8146:20 AM Description
Last accecs: Tuesday, Aprl 05, 2011 8:12:15 AM LibraryCategaries _35.CoDesys. ProjectinfoEditor LibraryCategory]

Attiutesis A | earveatsantvide  Suskam.Giiidl] =
Condenks: i
= (3 mi base v EF vl al |
5] GetBoolearPraperty
Company
NumberProperty
extProparty
2] GetTie
(E] Getversion
1E] GetVersonFroperty
+ L Data Types
+ 3 Error-ERagnostics Memory T
+ L3 Giobal variables List
+ 3 Internal (Do not use!)
hd } IP-Settings -4 |
4

Fig.3-140: "Details” dialog

For the currently selected library, this button opens a dialog that displays the
dependencies of other libraries, i.e. the integrated libraries are shown.

The title, version and company are displayed for each library.
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| Dependencies - ML_Base” MLC 125, 12.0.30.0 (System)

=2 #CmpErrors

0 #RIL_COMMONTYPES
#Z0 #RIL_UTILITIES
w2 #oysTime

[ #ovsTvpes

Close

4

Fig.3-141: "Dependencies” dialog

For the current library repository, the placeholders/compiler versions are dis-

played.

The list can be ordered according to placeholders or compiler versions. The

following two figures show the possibilities using an example.

The dialog simultaneously serves as export/import interface for library pro-

files.

Library Profiles

Flacehalder | Compiler version | Resolution

- Import. .. |

+- Placehalder: Skandard

+. Placeholder: Standardes

Placeholder: Lt |
‘- Compiler version: 3.4.2.0

- Placeholder: CD3_MemMan

- Placeholder: Collections

Util, 3.4.1.20 (Syskem)

- Placeholder: Plc Services

- Placeholder: SysTarget

- Placeholder: Tecvaraccess

- Placehalder: SymbolicvarsBase

- Placeholder: SM3_Basic

- Placeholder: 5M3_CMC

- Placeholder; SM3_Drive_Cis_D3P402

- Placeholder: SM3_Drive ETC

- Placeholder: SM3_Drive_ETC_DS402_Cyclicync

R B N B N = B = B = S

Sortby: % Flaceholder name { Compiler version

Expart... |

Close |

Flg.3-142:

"Library Profiles'dialog, ordered according to placeholder names
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Corpller virsion | Placeholder

+ Complley version: 3.4.1,0

[Flaceholde

U, 3.4.1.20 (System)

PFlaceholder
Placeholder: Tectarfccess
Placeholdar: SymbolicVarsBase
-Placeholder: SM3_Drive_ETC_DS402_CyclicSync
Placeholder: SM3_Drive. ETC_DS402_IF:
Placeholder: SM3_Drive CAN_DS402 CydicSyne
Placsholder: SM3_Drive CAN_DS402 1P
- Placehwolder: RecipeManagement
+- Compller version: 34.3.0
i Compller version: 3.4.0.0

4]

ColeSys Memary Manager, 3.4.2.0(35 - Sma
IecVarfccess, 3.4.2.0 (System)
SymbolicYarsBase, 3.4.2.0 {Systam)
SW3_Drive_ETC_DS402_ CycicSyne, 3.4.2.0 (0
Sp3 Drive ETC_DS40Z_IP, 3.4.2.0(35-5ma
SM3 Drive_CAN_BS402_CyeicSyne, 3.4.2.8.(
SM3_Drive_CAN_DS402 P, 3.4.2.0(35 - Sme
Recipe Management, 3.4.2.0 (System)

| i

Sortby: © Flaceholder name  © Compiler version

Clase |

Fig.3-143:

Generating a Library in IndraWorks

"Library Profiles” dialog, ordered according fo compiler versions used

The libraries of the IndraLogic PLC programming system contain function
blocks, functions, data types, variable lists and constants provided by the
control manufacturer. The libraries, page 83, are either directly installed dur-
ing the installation of "IndraWorks Engineering" and are visible in the library
manager, page 367, of the relevant application or they can be added from
the library repository, page 185,.

This section describes how the user can create a library or compiled library
from function blocks, functions, data types, etc. which is equal to the manu-
facturer's libraries.

For that purpose, the function blocks, functions, data types, etc. are to be ar-
ranged in the "General module" folder in a structured form.

In the context menu of the "General module" or in the main menu under
"Tools", three menu items are available

e "Generate library...*
®  "Generate compiled library...”
e "Generate and install compiled library...”

& Project Explorer

Fig.3-144: Menu items for generating a library or compiled library (confext menu)
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Loolsl window  Help

Update DTM Catalog

% Cormpare. ..

Drive 3

Ei Device Dakabase. ..

Indralogic project version,.,

Library Repository...

Generate Compiled Library. ..

Generate Compiled Library and Install...

(3

Fig.3-145: Menu items for generating a library or compiled library (main menu)

All menu items can only be used if the opened project contains a "Library in-
fo" object, page 371,. If no such object is available and the user selects one
of these menu items, the following message is output:

Indralogic

The Library Infa Object does not exist.

Fig.3-146: Error message, library info object not available (yet)

In this case, add such object by means of the context menu (or from the li-
brary):

@m Project Explorer
Praject14

lf_J General maduls folded =
T IE] POU_FRO) (FR o LbraryDrporti

=+ [l DCC_Control_01 «ddl Create Lbrary, .,
= [ Logi " Gerarste Compiled Library...

B 1M Mottt Bl &enerste Compiled Library and Instal, .

| Technology
add...

a‘ Robot =
m Onboard 140 Export... w3 Interface...

m InIinngD Irpart. . Ol: Data Tvpes. ..

mr Profibuz/t

Mot_Used % Compare... D Faolder...
Hf SERCOS B Paste Chrly ﬁ Global Variable List...
A o B ey, ]

Fig.3-147: Adding a library info object fo the planned library

In this object, at least complete the mandatory fields "Company", "Title" and
"Version".
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Library Info
File Surnmary |Properties I Statistics I
Company: IREXRDTH N
Title: [TESTLIB
Yersion: IIJ.IJ.IJ.1| /, [ Relzased

Library Categories: | |

Default namespace: I

Authar: I

Description: ;I

The fields in bold letters are used ko identify a library,

[ Automatically generate POUs for property access

oK I Cancel

Fig.3-148: Dialog: Library info object
If this was not performed or not performed correctly, the following message is
output.

Indralogic

The Library Info Object is not completed; the company, the title and the version need ko be specified.

Fig.3-149: Message. Mandatory parts of the library info object are missing

= This mandatory data is later used by the library in the library repo-
sitory.

The name of a library or compiled library is generally displayed in the details
of the library repository (normally, titte and name should match):
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| jiLibEary REpository I
Location:  [system
{CH\Dalumente Lnd Einstalungsrial
rates: [ |
(Al carnparies) =l | el [
i Miscellaneous) 3
3 pplication
Yisteon -
E3
ifperbes:
s =
Authar BRCJEAME (VK)
Compary Systenm
Disscripticrn Aryelie commurication thraugh cyelic fialdbus channel.
LibraryCategaries _35,Cobesys Praject InfoEdiar, LibraryCategoryl] =
LibraryCategorylds — Systerm.Guid[] i
| Titie 71 Parameterhannel =

GetBooleanPraparty
2] Getrrimpany
2] GethurberPraperty
@ GetTextProperty
2] GetTitle:
5] Getversion
2] cetversionpropeity
# 12 Parameter Channel

Fig.3-150: Library in the library repository
From now, the process and the result of the three menu items differ:

The user first of all selects a directory (and can change the name of the li-
brary file) in which the library is to be stored. It has to differ from the
IndraLogic directory of the currently opened project. If this is not the case, the
user is requested to select a different directory.
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CIWALLEADD
“3Dakumentation
~10okuments und Einstellungen
[lgskhop
. ‘ _IM3OCache
Figore D ateen 1 = NOPS
— _ipeacy sys
"I _iFrogram Flles
i L‘ s I Programine
Araeisplatz
RECYCLER:
L= secinst
: SWSHARE
(I | System Valme Information
biemg ke
| Indralomic bbrary files [* foeany] hod e
) = J

Fig.3-151: Dialog: Selection of the sforage location and the name of the library to

be generated
After the user has confirmed this dialog, the opened project is first of all
saved and then, the library file is generated in the selected directory (in the
preceding example in the path "C:\" the file "indralogic.library").

The "storage" name of the library only serves the finding and
@ management outside the library repository. It does not influence
the title in the "Library Info".

The user first of all selects a directory (and can change the name of the li-
brary file) in which the compiled library is to be stored. It has to differ from the
"IndraLogic" directory of the currently opened project. If this is not the case,
the user is requested to select a different directory.
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Create compiled library

Spechemin: | we [C] System FEOFE T
E - "‘Ba_t [(YaLUEADD
L “adaten (IWINDOWS

iDokumentation 'Iriﬂrai'.r:lgg!ﬁ. caripiled-library

Eigene Dateen

wr
oy 8

~iProgramme
Artepplatz ragr

i

LS
Netzwerhlmgs
buna

— System Yolume Informatian

(‘ i Indralogic J

ClE::mpiled Libraties [ compiled-ibrary)

Fig.3-152: Dialog: Selection of the sforage location and the name of the "com-
piled library” fo be generated

After the user has confirmed this dialog, the opened project is first of all

saved and then, the file with the compiled library is generated in the selected

directory (in the preceding example in the path "C:\" the file "indralogic.com-

piled-library").

The "storage" name of the "compiled library" only serves the find-
O ing and management outside the library repository. It does not in-
fluence the title in the "Library Info".

If the user selects this menu item, the "indralogic.compiled-library" file is gen-
erated in the "Indralogic" directory of the opened project and immediately in-
stalled in the library repository.

The data is taken from the mandatory fields "Company", "Title" and "Version"
of the library information.
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l | flLibrary Repository

| E— R

e

Library Profiles... |

Fig.3-153: Dialog: "Library Reposifory”, new library TESTLIB

3.6.6 Options

Options, General Information

The "Options" dialogs allow to configure the behavior and appearance of the
IndralLogic user interface. The default settings are determined by the current
profile.

The dialogs can be accessed in Tools » Options.

The current settings in the options dialog are saved on the local system as
default settings and they overwrite the settings made when installing
IndraLogic as delivered.

Indralogic 2 G options

®  Options, general settings, page 198

®  Export options, page 198

e  Visualization options, page 199

®  Options, declaration editor, page 201,

®  Options, sequential function chart, page 202,

®  Options, smart coding, page 205,

e  Options, CFC editor, page 207

e  Options, FBD, LD and IL editors, page 207

®  Options, device editor, page 211

e  Options, text editor, page 212

®  Options, syntax highlighting, page 219,

e  Options, sequential function chart editor, page 219,

®  Options, libraries, page 222,

®  Options, converter for IndraLogic 1.x projects, page 224
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Options, Indral ogic 1.x
e  Options, IndraLogic 1.x settings, page 225

Menu: Tools » Options * IndraLogic 2G > General settings.
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Options

[#- General

[ CamBuilder

-- Comparizon

- Indrawiorks D/MLD
(- Messages/nates
B- Indralagic 2G

- Wisualization

- Declaration editor

- SFC

- SmartCoding

- CFC editor

- FBD, LD and IL editor
- Device editor

- Text editor

- Syntax Highlighting

- SFC editor

- Libraries

- Indralogic 1. converter
- Indralogic:

[#- Technology

*- MLC

[~ DOpen obiect after inserting

V¥ Show device type in Project Explorer

- PLC Logger

]

Cancel

Apply

Reset

Fig.3-154:

"General seffings" option

e  Open document when inserting:
When this option is selected, new objects that are inserted into the Proj-

ect Explorer are opened immediately.

e  Show device type in the Project Explorer

The name of the object is extended with its device type.

e Activate PLC logger

Using this button, the "Log" tab of the device dialog of every control can

be activated.

Menu: Tools » Options * IndraLogic 2G » Export.

The format of the export files generated by IndraWorks can be set on this op-
tion page:
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& Binay fomet (compact)

wualzsion
Declaration edito
SFC
SmatCoding
CFC editor
FBD, LD and IL editor
Drevice editoe
Teud editor
Syntax Highlghting
SFC editor
Librasie:
Indral ogic 1.% Corvester
[#- Indralogic

—
- Technalogy
- MLE =l

oK. I Cancel Lpply Reset Help |

Fig.3-155: Opfions, "Export”
Exportformat  Format selection
e  With the "Binary format (compact)" setting, the objects selected by the
user for export are exported in a compact format (as far as possible).

The information associated with the PLC objects is integrated into the
export file in binary format.

e  When the "XML format" setting is applied, all of the objects selected by
the user for export are exported in XML format. This could cause very

Options, Visualizations large files.

Menu: Tools » Options * IndraLogic 2G > Visualizations.

General settings for working with visualizations in IndraLogic 2G are made in
this dialog.

General tab

| ¥

Gengsal |5m |

—Presentafion Bphions [Veusiizstion edtor in'the pogramming sedtem] ————————
™ Bestfitin onlne mode

IV Antizkased Drawing

—Fik= Ditiors
T file for textual InteliSarse:
] 2]
| Visuahzation Directonss i
Testlist files:
FBD, LD and Il editoe | _I
Ele—a':e_edra' p s
Ted editor r I |
Syriax Highlighting 1 =
SFC editor |
Libwasies
Irvdralogic 1% Cormester
= Inralogic 18]
[#- Technology
B MLC =
QK I Cancel | Apply | Feset Help |
4
Fig.3-156: Dialog for visualization options, general information
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Display options (visualization edjfor in the programming system)

Optimum size in online mode

This option has to be enabled the visualization is to be adjusted to the
current editor window size in online mode so that all elements are al-
ways visible.

Antialiased drawing
#Ht in preparation ###

File options

Text file for textual "List components":

In the input field located below, the name (including the path) of a file
(of .csv format) can be entered. It can then be used as a source for the
suggestions contained in the "List components" function during editing
of the 'Texts/Text' field within the properties of a visualization element.

This text file can come from the export of a global text list, page 288,. It
has a tabular structure which has to correspond to the structure of text
lists which is described on the help page for text lists, page 55,.

Visualization direcfories
- Text list files

Use the E] button to open the dialog for defining an existing or a
new directory for the language files that are to be used in the proj-
ect for configuring text and language in the visualization.

The files found in this directory are made available when a text list
is to be imported, e. g. after it has been processed externally by a
translator. Only one directory can be entered here.

For text and language configuration, see also the description in
Text lists, page 55.

—  Image files

Use the L] button to open the dialog for defining an existing or a
new directory for the image files that are to be accessible in the
project for visualizations. Enter several directories here in a list with
the items separated by semicolons.

Regarding image files, see also the description in Image pools,
page 61.
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Fig.3-157: Dialog for visualization options, Grid

Grid

Visible:

when this option is enabled, a grid based on the size defined below is
shown in the visualization editor for orientation purposes.

Active:

when this option is enabled, visualization elements can only be posi-
tioned on the points in the grid "size" defined below, no matter if the grid
is set as "visible" or only "active".

When inserting or moving an element this means that the center of the
element can only be positioned on one grid point.

When changing an element, this means that the small rectangle on the
element edge that is moved in order to change the size or form of the
element can only be moved to one grid point.

Size:
vertical and horizontal distance between the grid points in pixels.

Menu:Tools » Options » IndraLogic 2G » Declaration Editor.

This dialog enables general settings to be made for working in the declaration
editor, page 326.
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Fig.3-158: "Declaration edifor options” dialog
The display for the declarations can be specified:
Only textual
Only tabular

Switchable between textual and tabular: If this setting is activated, there are
two buttons in the declaration editor window by means of which it can be
switched between the textual and the tabular form.

In this case, one of the following settings defines which of the two views is
used by default upon opening of an object in the editor:.

e  Always textual
e  Always tabular

e  Save latest setting (per object): If an object is re-opened, the declaration
editor appears in the same view as during the last editing process.

®  Save latest setting (global): If an object is opened, the declaration editor
appears in the same view as during its last use, regardless of the object.

Menu: Tools » Options » IndralLogic 2G » SFC.
The default settings for SFC objects can be defined in this dialog.

Each new SFC object is automatically then provided with these settings in its
properties.

= The changes to the settings made here have to be transferred ex-
plicitly to existing SFC objects.

See Modifying the properties of existing POU objects, page 205.

Note that the basic editor options, page 219, i.e. settings for layout and dis-
play are managed in a separate options dialog ("SFC editor").
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.

Cancel

Apply
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Fig.3-159: SFC options, compilation

SFC library:

The SFC library defined here is used by default for new SFC objects. Compa-
ny, Title and Version are entered as they are in the project settings for the
library as delivered. A namespace can be entered as well in order to uniquely
address a library. This could be necessary if several versions of the library

are available on the system.

When entering a namespace, however, always ensure that the space entered
here is the same as that defined in the Library manager, page 368, for the

library!

By default this dialog contains settings for the Sfclec.library library, which is
delivered along with the standard profile.

Code generation:

Calculate active transifions only: When this option is selected, only the cur-
rently active transitions are calculated.
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= Indral ogic 26 O SFEror [Z]  ets TRUE, IF & time check Failed,
Bt Setins [ SFCEnsbletinit F  Erebletmechedionsteps
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Vm [0 FcErarPoll ¥ Contains the name of the POl that caused 5
Deciarsbion editat [l SFCCuitError ™  Execution s stopped. SFf::Errur is reset, SFCEr
S ¥ SF(Pause ~ Execation is stopped, SECError is reset.
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Fig.3-160: SFC options, variables

All possible "flags", i.e. implicitly generated variables for monitoring and con-
trolling the processing in an SFC chart are listed here. A short description is
included in the dialog.

Detailed information on the flags, see page 414.

Clicking on the checkbox for a flag variable enables automatic declaration
(Declare) and use (Use). These settings are then accepted as default set-
tings for new SFC objects.

If "Declare" is selected but "Use" is not selected, the variable is declared, but
the flag has no function during processing.

= Note that a flag variable with automatic declaration is visible in the
declarations of the SFC editor only in online mode!
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Fig.3-161: Example of an SFC error flag in the online mode of the editor
A timeout is indicated in step "s1" in the SFC object "POU" by the SFCError
flag.

Since modified options are only effective for newly created POU objects, ex-
isting POU objects have to be modified later on (right click, "Properties"):

Modifying the properties of exist-
ing POU objects

3 Project Explorey - 8 X
= 2] DEC_Contral
L General module folder

(=] DEC_MationControl
BBl lege | Fegs [ |
= s Application ;
—— @ MicvarGiabalf te_[ van Dedare_| Description
Use/arl [ st &l steps-and actions are resst, The init step is ackiv
Library Manst [] sPcReset &l steps and actions are reset. The it step is ac
2] PAUEEl O Srcemrar Gets TRUE, F a tine theck Failed,
] MotonProg SFCEnableLimit Enable time check on steps
5] ?:ug {PRE E1  sFcErorstep [l Coriains the name of the step that caused SFCEm
e Ef}‘gi’: £ sreemapou Cortains the name of ths POLI that caused SFCEM
= Prothus/M (Piofbus T sFcouitEror Execution s stopped, SFCErrar |s resst, SFCError (s
#= PROFINET_IO_ Controller A=l ! ool Y il R
= m Motion RN EEET N | Exemition|s stopped, SFCEOrBresets
T Tl Tty [ sFCirans Gers 'TRUE', if atransition switches through,
& Aokt [] sFCCurrentStep Conkains the name of the active step,
- SEACDOS [0 SFcTip Switches the nest transition on-a rising edae.
[} Deboad 10 (Orbaaed 110) [] sFTipMade IF'TRUE', tramsiions can only be sw\'tche_d ﬁy mear
= 7] Infne 10 [nfne 1/0)
@ R8I 24 DO.8) 4 Jl s ssnnnnns i
T RIEIL24 D18 e
K I Cancel I Apply I

Fig.3-162: Modifying the SFC settings for an individual POU object

Options, Smart Coding

Menu: Tools » Options * IndraLogic 2G » Smart coding.
This dialog contains settings that makes entering code easier.
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Fig.3-163: Opfions, smart coding
Declare unknown variables auto- When this option is selected, the Declare variable, page100, dialog opens automati-
matically (AutoDeclare) cally as soon as an identifier that is not yet declared is entered in a language editor

and the user moves beyond the input line.

List components after typing a dot  This option enables the List components function, page 103,

() That means that if a dot (.) is entered in an editor in a position in which an identifier is
expected, a selection list appears with the possible inputs at this position.

List components immediately when  If this option is selected, after any character string is entered in an editor, a selection
typing: list appears with the available identifiers and operators. This is also a type of "List
components" functionality.

The first entry in the selection list that starts with the same character string as that
which was entered is automatically highlighted as the selection and can be accepted
at the cursor position by pressing <Enter>.

Otherwise, another entry can be selected from the list.

Convert keywords to upper case If this option is selected, all of the keywords are automatically written in upper case
automatically (AutoFormat): letters.

Example:

When

bVvar:bool ;

is input, it is converted to
bVar: BOOL;

Automatically update cross referen- If this option is enabled, the cross reference list, page 107, automatically displays a
ces when changing selection: list of the references of the variables that are currently in focus in the editor.
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Options, CFC Editor

Options, FBD, LD and IL

Menu ltems

Differences from Indral ogic 1.x with regards to the cross reference list:

L The cross reference list can be displayed in a window (view) next to the editor
window.

L The project does not have to be compiled in order to display the cross referen-
ces.

L Component accesses, enumeration constants and user-defined data types are
also displayed.

L A dynamic display of the cross references for the respective variable in focus
can be enabled.

Menu: Tools » Options » IndraLogic 2G » CFC editor.

This dialog enables general settings to be made for working in the CFC edi-
tor, page 309.

Dptions
#- General | ¥ Enable AutoConnect
+]- CamBuider {When you drop elements somewhere on the canvas, unconnected pins that are bauching
+|- Comparizon each other are automatically connected if this feature is activated. This can be helpful for
3 Indrawdorks DAMLD quick editing, but be careful that you are not making connections accidentally by maving
+- Messages/notes slements around.)
=- Indral ogic 2G
General Settings
Export
Visualization

Declaration editor
SFC
SmantCoding
FBD, LD and IL editor
Device editor
Text editor
Syntax Highlighting
SFC editor
Libraries
Indralogic 1.x Converter
+|- IndraLogic
+- Technology

- MLC j

QK | Cancel Reset Help |

Fig.3-164: "CFC Edifor Options" dialog

Enable AutoConnect
If this option is active, the following applies:

If a CFC element is dragged and dropped somewhere on the editor working
area, unconnected pins that are "touching" each other are automatically con-
nected. This might support faster editing; however ensure not to generate un-
wanted links accidentally when shifting elements!

Menu: Tools » Options * IndralLogic 2G » FBD, LD and IL
The FBD/LD/IL editor is configured in this dialog:
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Fig.3-165: Options for displaying the FBD/LD/IL editor
View
Show network title The network title - if defined - is displayed in the upper left comer of the network.
Show network comment The network comment - if defined - is displayed in the upper left corner of the net-
work. If the network title is also displayed, the comment appears in the line below.
Display function block symbol If a function block or a function has been provided with a symbol (bitmap) via a library
or via the object properties, it is displayed in the function block element in the FBD
and LD editor. The standard operators are provided with symbols, as well
1 777
ez TOH
0 mo o
2Py PT ETf—2z2¢
Fig.3-166: "Show function block symbol” option nof activated
1 2p2
»rr TOH
N ey
222 PT ﬁ ET 222
Fig.3-167: "Show function block symbol” option activated
Show operand comment The comment that might have been added to a variable in the implementation section

of the editor is displayed. The operand comment refers only to the local use position
of the variable, in contrast to the "symbol comment" which is indicated in the declara-
tion of the variable.
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Show symbol comment For each symbol (variable) which has been provided with a comment in its declara-
tion, this comment is displayed above the variable name. Note that in addition to or
instead of this comment, a local "operand comment" can be assigned, as well.

Show symbol address For each symbol (variable), the address that might have been assigned is displayed

above the variable name.

Behavior

Placeholder for new operands: #H## in preparation #HH#

Empty operands for function block

. ###H# in preparation ###
pins

Fixed size for operand field

The FBD, LD and IL editor automatically adjusts the size of the operand comment fields.

If this option is selected, the following parameters define the display size of the information fields for an operand:

Width of operand field Maximum number of characters that can be shown for operand name.

Height of operand field Maximum number of lines that are used for the display of the operand name.

Height of operand comment Maximum number of lines that are used for the display of the operand comment.

field

Height of operand symbol field Maximum number of lines that are used for the display of the operand symbol.
FBD

General  FED |LD IIL

View
™ Metwarks with linebreaks
™ Connect boxes with straight

Behaviour
Defaulk network, content

After insertion select

IEmpt';.-' - I
INetwu:urk - I

Fig.3-168: Opfions for displaying the FBD editor
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View
Network with line breaks If this option is selected, the networks are displayed with line breaks so that the larg-

est number of function blocks possible can be displayed in the current width of the

editor window. Consequently, the networks might require more height.

If the editor window is not wide enough, the networks are not wrapped.
Connect function blocks with If this option is selected, the elements are arranged in a network so that the lines be-
straight tween them receive a fixed, short length and the width required for displaying the net-
lines works is reduced to the largest possible extent. Consequently, the function block box-

es might be extended vertically in order to create enough space for the input and out-

put elements.

If this option is not selected, the elements maintain their standard size and the con-

nection lines are modified to fit within the space required.

1
ADD ADD
ivarl —
ivars
ivar3_werylongidentifier
Fig.3-169: Opfion disabled:
1
DD ADD
iwarl— —
iwars—] iwvar3d_werylongidentifier—)

Fig.3-170: Opfion enabled:

Behavior
Network content This selection describes which content is displayed after the insertion of a new net-

work in the editor window.

(Empty, assignment, empty block).
Selection after insertion This selection describes which element is selected after insertion of a new network.

(Element, network).

LD
Gereral|[FED D |1 |
Wi Eehaviour
[ metworks with linebreaks Defaulk netwark content Ermpky -

petwork <]

Fig.3-171: Opfions for displaying the LD edifor
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View

Network with line breaks

If this option is selected, the networks are displayed with line breaks so that the larg-
est number of function blocks possible can be displayed in the current width of the
editor window. Consequently, the networks might require more height.

If the editor window is not wide enough, the networks are not wrapped.

Behavior

Network content

Selection after insertion

This selection describes which content is displayed after the insertion of a new net-
work in the editor window.

(Empty, contact and coil, empty block).
This selection describes which element is selected after insertion of a new network.

(Element, network).

General |[FED |0 L

Wigta Behawiour

Default network conkent IEmpty vI
After insertion select INetwu:urk vI

Fig.3-172: Opfions for displaying the IL editor
Behavior

Network content

Selection after insertion

Options, Device Editor

This selection describes which content is displayed after the insertion of a new net-
work in the editor window.

(Empty, LD and ST, CAL).
This selection describes which element is selected after insertion of a new network.

(Text, network).

Menu:Tools » Options * IndraLogic 2G » Device Editor.

This dialog enables general settings to be made for working in the device edi-
tor, page 331.
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Fig.3-173: "Device edifor options” dialog

The "View" subdialog contains the Show generic device configuration editors
setting.

= This option enables

1. the "Field Bus Diagnostics" tab in the object properties for
PROFIBUS DP master and PROFINET IO controllers.

2. For devices that can be parameterized (field bus objects),
the configuration dialog is available.

Options, Text Editor, General Information

Menu: Tools » Options * IndraLogic 2G > Text editor.

This dialog contains settings for working in one of the text editors:

Tabs

° Editing: Defining Undo steps, tabs, indentation, breaks, etc., page 212
® Text area: Color and font definitions for the text area, page 215

e  Margin area: Definitions of colors, font, mouse activity in the margin of
the editor, left of the text area, page 217

e  Monitoring: Enabling/disabling Inline monitoring, display of monitoring
fields, page 218

Options, text editor, editing

Defining Undo steps, tabs, indentation, breaks, etc.
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Fig.3-174:

Opfions, text ediitor, editing

Number of Undo steps

Fold (outline form):

The number of editing steps entered here is saved and
can be undone with the "Undo" command.

The selected option determines if the code is to be struc-
tured using indents. If yes, indented sections or sections
that are identified by a special comment can be hidden or
shown by using plus and minus signs placed before the
first line of the respective section. The following options
are possible:

None: No indent.

Indent: All lines that are indented relative to the previous
lines are collected into an "indented unit" with a sign
placed before the preceding line.

Examples: The lines between VAR and END VAR or be-
tween IF and END_IF are indented, Thus, they are collec-
ted in an indented unit marked with a minus sign in front of
"VAR" when open and a plus sign in front of "VAR" when
closed.

Open and closed indented units:
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fold opened fold closed
prog_st | TaskconFig [Re prog_st | Taskconfig [F
1| PROGEAM prog st 1| FROGRAM prog st
= Z| VAR + E|VAR [Z limes]
3 ivarl: IHT: 5| EHD_VAR
4 ivarzZ: IHT:
5| EHD VAR

Fig.3-175: Opened and closed indenfed units (declaration)

fold opened fold clozed
= 1 IF a:=1: + 1 IF a:=1; [4 limes]
z THEH & EHD IF
3 b:=0; 7 Cci=c+l;
4 ELSE
3 b:=1;
& EHD IF
7 ci=c+l:

Fig.3-176: Opened and closed indenfed units (ST)

Explicit: If this option is selected, the code section which
includes an indented section is identified explicitly with
comments: A comment that includes three opening curly
brackets "{{{"" has to be located in front the section; anoth-
er comment that follows the section has to include three
closing curly brackets "}}}". The comments can include ad-
ditional text.

Example of the definition of an indented section by using
special comments:

1 I h 'THEH
= 2| s
3 IF & THEH
4 c:=THUE:
| mw_tr
8l 4 b
A
- Z A4/ copmentcopient {{{ compentoomment
)| 1P 2 THEW
4 co=THOE ¢
£ EHD IF
a Py Y|
T EHD_'IE'

Fig.3-177: Indented section explicitly defined by special comments:
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None: The lines are wrapped endlessly.
Soft: The lines are broken at the margin of the editor win-
dow if a "0" is entered at the break position.

Hard: The lines are broken based on the number of char-
acters entered at the break position.

Tab width in number of characters.

If the Auto Indent option (see below) is enabled, an inden-
tation to the right is made here based on the number of
characters entered, i.e. a corresponding number of spaces
are inserted at the beginning of the line.

Never: No automatic indentations are made during editing.
The character strings entered always start at the left mar-
gin of the text area.

Block:

Smart: The lines following a line that contains a keyword
(e.g. VAR or IF) are automatically indented based on the
Indent width listed above.

Smart with code completion: The lines following a line that
contains a keyword (e.g. VAR or IF) are automatically in-
dented based on the Indent width listed above and in addi-
tion, the corresponding closing keyword is inserted (e.qg.
END_VAR or END_IF).

If this option is selected, an empty space in a line inserted
with the <Tab> key, based on the defined Tab width (see
above), is not broken down into individual single spaces.
This means that if the tab width is changed, the empty
spaces created wit the <tab> key are modified as well.

Options, text editor, text area

Color and font definitions for the text area

- General
[ CamBuilder
[#- Comparizon

- Messages/nates
=1 Indral ngic 2G

Expast

Virualzahon

Iil Indralogic
- Technalogy
- MLC

[ Indratworks D/MLD

General Sefiings

Editing {TEXE 325 | Margin | monitoring |

[+ Highlight current line: II:lLightYeHU vl
[v Matching brackets: I-Black vl
I Endof ns markers: | EEET=A ']

T Wran guide: [ERstecbie <]

Carst color: Ik -

Selection color: |Elighestesl =
olded line foreground: | EEEIT=al -

E
&

oided lins backaroandi | ClightGray =

Foat (chick ontothe sample to edit):

AaBblckXTYIz

oK. I Cancel Lpply Reset Help |

Fig.3-178:

Options, text edjfor, ftext area

The following options can be enabled for better optical support during editing:

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



216/697 Bosch Rexroth AG DOK-IWORKS-IL2GPRO*V12-AP01-EN-P
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

Menu Items
Highlight current line: The line that contains the cursor is highlighted with the set
color.
Matching brackets: When the cursor is positioned before or after parentheses

"(" or")"in a code line, the matching closing or opening
parenthesis is marked with a frame in the set color. Like-
wise, if the cursor is in the first or last line of a parenthe-
ses-enclosed expression® the corresponding last or first
line of this area is shown with a square frame in this color.

End of line markers: The end of each editing line is marked by a small dash in
the set color after the last character in the line (including
spaces).

Line break position: If a soft or hard line break is enabled (see above, 'Editing'

dialog), the defined line break position is shown with a ver-
tical line in the selected color.

Caret color: Color of the cursor
Selection color: The currently selected text area is highlighted with the se-
lected color.

Folded line foreground:  The header of a closed, indented section in the code is
displayed in the selected color.

Folded line background: The header of a closed, indented section in the code is
highlighted in the selected color.

Fonts: The font set here is used in the text editor. Click on the
sample field to open the standard dialog for configuring the
font.

= T __—-Malching Drachets
: W o
E]prog_st |@ Tl :
1
] 2 Mighlight currentiine
[ o3 2 it End of line markers
; N |
[ IF a:=1; [ Iinesd ﬁ‘_“]L—-_._ Folded lire patkground’
o S \ET“-'- Foiged fine foraground
ci=t+1; =
= 7 IF
i - —— lirap guide
9] iv&t:%‘xr e
LG EHD IF . v_-‘
2] i =
T \Matching bracksis
= H 1 i
i e
‘ a ivarkEEr ¥ i el

Caref color

Fig.3-179: Example seftings for the text area

1) A parentheses-enclosed expression includes all of the lines befween the starting
and end keyword of a construct (e.g. all of the lines between IF and END _IF). See
also the "Margin area” subdialog.
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Options, text editor, margin area

Definitions of colors, font, mouse activity in the margin of the editor, left of the

text area
= Goreral = I1ﬁtw§a — _..:_.- | — [
= CamBuildesr
= Inckwlorkis D/MLD ¥ Line rumbiering . Hiolee oo
= Mestages/nates Fareground calor: EisteclElus | Click: - |Ta|_;|gIE.Fn|d -'."[
= Indral ogc 25 S Sl s el =]
Gioneid Settinas Background color: [ Iwhits = Shift:Click: Select fold ~
Expoet mem [-ﬁrebrlck b ClrkClick; |TaggIeFuIdFuﬂy "'[
D Ry [V Show backet scopet | IEESteclBlue = A-gle [None -
SFC Foctised bardst color; | MEMTesl x|
CFE editor Unfocused barder cofar: CuightGray =)
FBD, LE and I editor
Devl:e_'ec&n
Tes edlr Fogt (e ok the ssmple fo o)
Syntax Hichichting
ﬁ;?::ﬂ 4=BBCoHRTYEZ
- Indralogic 1.4 Carverter
- IndraLogic
- Technalogy
- MLE =l
oK. I Cancel Lpply Reset Help |
%
Fig.3-180: Opfions, text edifor, margin area

The following settings and options refer to the left margin area in the text edi-
tor window separated from the input area by a vertical line.

Line numbering:

Foreground color:
Background color:

Current line:

Parentheses-enclosed
expression:

Focused border color:

Line numbers are displayed in the declarations and in the
implementation section of the text editors, always starting
with 1 in the first line.

Color of the line numbers
Background color of the margin area

Color of the line number for the line in which the cursor is
currently positioned

A parentheses-enclosed expression includes the lines be-
tween the keywords that open and close a construct, e.g.
between IF and END_IF.

The bracket scope function can be enabled using the
'Matching brackets' option in the "Text area' dialog.

If the cursor is positioned in front of, after or within one of
the corresponding keywords, the bracket area is displayed
with a bracket in the margin.

Color of the vertical separating line between the margin
area and the input area in the currently active section of
the text editor window.
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Menu ltems Unfocused border color:  Color of the vertical separating line between the margin

Mouse actions:

area and the input area in the section of the text editor
window that is not currently active.

One of the following actions can be assigned to each of
the specified mouse movements or mouse shorcuts (click,
<Shift> + click, <Ctrl> + click, <Alt> + click).

The action is executed if the mouse movement is executed
on the plus or minus sign positioned in front of the header
of a parentheses-enclosed area:

None: No action.

Select fald: All of the lines in the parentheses-enclosed
area are selected.

Toggle fold: The parentheses-enclosed area, or in the
case of nested enclosed areas, the first level of the paren-
theses-enclosed area, is opened or closed.

Toggle fold fully: All levels of a nested parentheses-en-
closed area are opened or closed.

Options, text editor, monitoring

Enabling/disabling Inline monitoring, display of monitoring fields

[#- General

FBD. LD ard I editor

Device aditor

-- Messages/notes Manitoring fareground color: I IEack hd l
= Indkalogic 26
Sgee? Montoting background coldr: [IPeachPuff vi
General Seting:

Flow cartral Fareground calor: IE ack -
Flow corjtral Background calar: [rFaleGresn vi
Flogt precision: 3 E: digits
String fength: 10 5: characters

Editing I Text area I Margin :

[+ Enable inline monitoring

Teut edicn Monkoring sampls: Flow contral sampls:
Syritax HighBohting
SFL edfor EaBNCEGYE: BaBbCEN T
Lianes
Indral. ogec 1.x Converter
Indralogic JI
- Technology
- MLC =]
oK I Cancel Lpply Reset Help |

Fig.3-181:

Opfions, text editor, moniforing

Enable Inline monitor-
ing:

Foreground color:
Background color:

Sequence control fore-
ground color:

Sequence control back-

ground color:

The display of monitoring fields after variables in a text ed-
itor in online mode can be enabled and disabled.

The value in the monitoring field is displayed in the selec-
ted color.

The background in the monitoring field is displayed in the
selected color.

The value in the monitoring fields at the sequence control
positions is displayed in the selected color.

The background of the monitoring fields at the sequence
control positions is displayed in the selected color.
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Menu ltems

Floating point precision: Numbers with decimal points in the monitoring field are
displayed to the number of places set here.

String length: String variable values are displayed in the monitoring field
to the maximum length entered here (number of charac-
ters)

.. Preview: Preview of the values currently set for a monitoring field

Preview of the values currently set for a monitoring field

ol 481 |i=c| 431 |+l.:
o[ 235k li=2.34566;

StY_war[ab ko _=I=§.Et:1:te—'_.:.___ i

bFALSE: =FALSE;

LR I

Fig.3-182: Example of Inline moniforing in the ST edifor
For a preview with the values just set for the sequence control refer to Se-

quence control in the different language editors, page 148.
Options, Syntax Highlighting
Menu: Tools » Options * IndralLogic 2G » Syntax Highlighting.

This dialog contains color and font settings for the various text elements in an
editor (e.g. operands, Pragmas, comments, etc.).

Dplions B
% ‘Ef'?ﬂ 21 psplay kems: Ttem fareground:
CanBuildes
i = % B Olve '1
+ - Lompanion DATE literal
- Indraw/grics D/MLD CATE_AMND_TIME literal
= Mestanes/noles TIME literal Ttem background:
= Indral 5 TIME_OF_DAY fiteral Wi i
£ f_m_l o Diouble-byte string licsral il ~
okt Sighe-byte string iteral
Expait [nteger literat Tt font styla:
Vicuakeation Real fberal I
Declaation e Commsnt .'_J l] _.d __u.J -S_I
SFC
SmariCodng Seampls:
EFT editor
FED, LD and 1L editor

Indral ogic 1.% Corverter
- Indralogic
-- Technology

|
MLC LI

QK I Cancel | Lpply | Reset Help |

Fig.3-183: "Options” dialog, syntax highlighting category

Both color and font for the text editor display can be set for the text elements
listed in Display items. A selection list can be used to set the color for the
item foreground and the item background. The item font style is defined by
clicking the desired symbol for "bold" (B), "italic", "underline" and "strike-
through".

An example of the current settings can be seen in the Sample (preview) win-

Options, SFC Editor dow.
Menu: Tools » Options » SFC (sequential function chart) editor.
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The dialog contains tabs in which the settings for the SFC editor, page 399,
can be made.

T
& General =] Layout |view |
& CamBuildes B
= i ~Elements
& Indraworks DUMLD S ) lﬂ
= Meszages/notes Step heigit: -
- Indral ogic 26 . I‘ﬁ.
Beneral Sattinas g e —
Expost L
s seonvidh | 6 =
Dreciamtion edito e =
e Quialifir width; l 3 3- |
SmarCoding o =
CFT et ‘Property width:. I & 3- |
FED, LD and I editor
Drevice editoe
Text edior
Syntax Hichichting
Libwases
- Idratogic 1.4 Carvarter
(- Indralagic ||
-- Technology
MLC LI
QK I Cancel | Lpply Reset Help |
¥
Fig.3-184: "SFC edifor options” dialog, layout

In the "Layout" tab, the values are entered in "grid units".

1 grid unit = font size currently set in the text editor options (Text area/Font).
Step height: Height of a step element. Possible values: 1-100.

Step width: Width of a step element. Possible values: 2-100.

Action width: Width of an action element. Possible values: 2-100.

Qualifier width: Width of the qualifier. Possible values: 2-100.

Property width: Width of the display area for the step properties. Possible val-
ues: 2-100.

The settings are always effective immediately in all currently open SFC editor
windows.

Init
TETE . Galifier width
Step height | —
=1 u! I N actl I
?| EJThis iz 3tep =1. 1 ]
| | | Minimal actiwve: t#i= Action wicth
Step wickth Maximal active: t#ds

3tep actiwe: actl
3tep entrv: entryactl
Step exit: exitactl
Symbol: Fead

L ]
Propetty width

Fig.3-185: Setting parametfers for the layouf in SFC

View The "View" tab is described in the following:
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B [ vobe | withnane |
= 2 Step
= Comman
Comment L]
Symbaol | |
= SRk
Minimal active £l ]
Maximat active [ 2
Step active i} ]
Step entry O |
- = Transition
Comment 5| E
~ Symbal = £
= ' Jump
=i {#‘l‘l‘l‘m =
 Comment il | |
= H ™Macs
= {Common
Commmerit = o
— @& Branch
. e Zomment |:| |:|
- m Action association
= Camrmon
- Comment ] ]
- Symbol ] ]

Fig.3-186: Visibility of the properties, SFC edjfor options, view

Visibility of properties:

Define here which element properties are to be displayed next to the element
in the SFC chart. For each property, checkmarks can be placed in the "Val-
ue" column and in the "With name" column. If the "Value" column is selected,
the value is shown in the chart. If the "With name" column is selected, the
property name is shown.
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Menu ltems Example:
Element propertiss: Editor Viewy options
"7} Properties
{ Fiter = ¥ sortby - &l sortarder - Lot vew |
ety telue - |
= Common [ais | vithnams |
[arie 51
Comment This iz Stepsl. .
= Spedfic = =
initisd step i
= Timzs
Minimal ac_ (@ '
Maximal ac_ t#4s =
- names
Stepexit:  ewtact] == Sl

Imnit
E'I:!TREE Teis 23 Step 51,
=1 Syabol: Fesd
BEinimal
Masimal
ﬂ E St&p a
Step 2ntry: entryactl
Step exit: exitactl
tl
Bram..
52

Fig.3-187: Element properties

Online:  If the Show step time option is selected, in online mode the current step time
is displayed to the right of all of the steps for which time properties have been
defined.

T#Oms

T#1s4035ns
Thiz iz 3tep =1.

Mimvimal artiwe=- r#

Fig.3-188: Example display of a step time in online mode
Options, Libraries
Menu: Tools » Options > IndraLogic 2G » Libraries.
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The "Mappings" of library references that are used when converting an "old"
project are managed in this dialog. Until a "mapping" for a specific library is
saved here, define it every time an old project is opened that includes this li-
brary.

See information on opening and converting projects in the current format,
page 116.

See information on library management, page 83.

A "mapping" defines how a library reference should appear after the project is
converted into the current format. There are three possibilities:

®  The reference is kept, i.e. the library is also converted into the current
format (*.library) and installed in the local library repository.

® The reference is replaced by another, i.e. one of the installed libraries
replaces the one that was previously included.

®  The reference is deleted, i.e. the library is no longer included in the con-
verted project.

If the "mapping" is saved, it is added to the option dialog in the 'Libraries' cat-
egory:

) Garieral a| Whenevsra profact s converted from the old to the new fils farmat, the lbrary cafsrences in

1 CamBuildsr this projct willbe replaced sccarding to the fallawing mapping table:

- Comparizon -

Indrwfarks D/MLD “ource Library, | Target Library, =]

[ Messagesinotes mt_utilties, b RIL_Litilitles, "™ {Systam)

1= IndraLogic 2G nietvarudp_lib_vz23.lib (lanorieren. Diese Biblioth
Getieral Setings plcopenfisldbus. i PLCopenFieldBus, * (Syst
Ewupor Hl_checkrtw lib RIL_CheckRlw, * (Systemn)
Mizualization til_commontypes.lib RIL_CommonTypes, * (S
Dieclaration editor tll_ethernetip.lib RIL_EthernetIp, *{System
SFC tll_loopeantrol.lib RIL_LoopCantral, * {Syskal
%martEleng til_mindbustep. lib RIL_ModbusTCR, * (Syster-
CFC edior ] Hl_prafbwsdp b | Bl Bfeibusbe. 7, * (S
FBD. LD and IL editor rl_prafibusdp_02.ib RIL_ProfibusDP_02, * (Sy
?ewc:edltnr til_socketcomm.lib RIL_SocketComm, * {Syst
Se::; "_tf'hl_ i Hil_utilties. b RIL_Utiities, * (System)
SiE editol? g il el lib (Ignovieren, Diese Biblioth
liesas standard, i Standard, * (System) 5
Indralogic 1.4 Canverter o T F| o

- Indral ogic I

#- Technology

) MLC =

QK ] Cancel Apply Fesel ] Help ]
P
Fig.3-189: Opfions for libraries

All mappings listed here are applied to the library references of the next old
project that is converted. Thus, the mapping definition does not have to be re-
peated if the same library is included again in a project to be converted.

Each "mapping" is displayed on one line:
Source library: Library path included in the project before conversion

Target library: Name and storage location of the library that is to be included
in the project after conversion. If the reference is to be removed, this is
shown in the text "(Ignore. This library reference will not be converted.)".

The mappings list can be edited: To do this, double-click on the respective
field or select a field and press <Enter>.

When editing a source library entry, the _I button opens the standard
browse dialog in which it can be searched for a library in the "old" format.
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Menu ltems When editing a target library entry, the 'Set target library' dialog opens.

Set Target Library

| Browse, .. |

Ignore, This library reference will not be imported., |

Cancel |

Fig.3-190: ‘Sef Targeft Library’' dialog

To open a library in the current format, the Search button can be used to
open the Select Library dialog where one of the libraries installed in the local
library repository can be selected.

It can be sorted according to company and category, as in the library reposi-
tory dialog, page 185,.

Use the <lIgnore. ...> button to specify that the present source library is to be
removed from the project forever when the project is converted.

A new entry can also be added to the list directly from this dialog by editing
the last line, "(Insert new mapping here.)".

Options, Converter for IndraLogic 1.x Projects

This dialog can be accessed using Tools » Options » Converter for
IndraLogic 1.x projects.

The "mapping" for converting IndraLogic 1.x projects is defined in this dialog,
i.e. it is determined how the components of a project are handled when they
are transferred into the current project format.

In the 'Device' tab the conversion of the device references (which target sys-
tem is used) is described:

Until a "mapping" is defined for a device in this dialog, you are prompted to
define one if an old project that used this device is opened.

See information on
®  opening and converting projects in the current format, page 116.
¢ handling devices in the Project Manager, page 63.

A "device conversion mapping" defines how the reference should appear on
a target system after the project is converted, i.e. a "target device" (device in
the new project) is assigned a "source device" (original device in the old proj-
ect). There are two possibilities:

® In the device tree for the converted project, the source device is re-
placed by the target device that is currently available on the system, i.e.
is installed.

®  The source device is not converted (is ignored), i.e. it will not appear in
the device tree for the new project. In this case, even application-specif-
ic objects such as the task configuration are not transferred into the new

project.

A device mapping can be defined and saved ...

e ... while converting an old project that uses the device (see the descrip-
tion of the Data transfer, page116 command)

e .. or by direct entry here in the converter option dialog on the 'Devices'
tab:
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& CamBuider
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V2,100 Bosch Rexroth AG

L

QK I Cancel |

Fig.3-191: Indral ogic converter options

To edit a field in the mapping table, double-click on the field or select it and
press <Enter>. Assign each "source device" a "target device":

For entries in the "source device' column, the 'Select original device' dialog
opens, where all devices that the converter can handle are listed. Select the
desired device to insert in into the field.

For entries in the 'target device' column, the 'Select target system' dialog
opens, where one of the currently installed devices can be selected. The dia-
log is managed like the Device database dialog.

= If 'None' is selected, the source device is not be available in the
new project, which also means that application-specific objects
such as the task configuration are not transferred!

All device mappings listed in the Options dialog are applied the next time an
old project is converted. In this way, the mapping definition does not have to
be repeated if the same device is used in several projects.

Options, IndraLogic 1.x, Settings

This dialog can be accessed using Tools » Options > IndraLogic (1.x), set-
tings.

= These options are only in effect when working with IndraLogic 1.x!
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i Geparal | Genelal [
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i Indralogic 2G
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Fig.3-192: Opfions, Indralogic 1.x seffings

General

e Extended dialog and message display
#Ht in preparation ###

Start opfions

e  Start IndraLogic in debug mode

If a project was created in IndraWorks with a 1.x control, double-click
the "Logic" node (or its objects), IndraLogic 1.x opens. When it opens,
information is displayed in the message window.

If the checkmark is placed next to "Start IndraLogic in debug mode",
these messages are also recorded. The "ILStartingMessages.txt" proto-
col is stored in the IndraWorks installation directory in the IndralLogic
folder.

e  Updating rate of the online information
#Ht in preparation ###
e  Time monitoring for the IndraLogic start

When Indralogic 1.x is opened, a monitoring period begins. If
IndraLogic does not start within this time period, an error message is
output.

3.7 Library Manager - Commands
3.7.1 Library Manager - Commands, General Information

The commands for the Library manager, page 367 can be called from its edi-
tor window. Furthermore, the "Add library" command can be accessed in the
menu bar as soon as the editor is activated.

If required, the menu configuration can be changed using the dialog in
IndraWorks > Tools » Customize.

®  Add library..., page 227
®  Properties..., page 230
®  Reload library, page 231.
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Menu ltems

For general information on the IndralLogic 2G library management, see page
83.

3.7.2 Add Library...

By default, this command is available in the Library menu, page 371, and in
the Library Manager window, page 368,.

Use the command to add a library to the project using the currently active Ii-
brary manager.

Only libraries installed in a local repository, page 185, can be added. Several
versions of a library can be used simultaneously in the project using one or
more Library managers.

The command opens the 'Add library' dialog.

To insert a library to your project by default only consider the Library tab dia-
log.

The Placeholder tab dialog is only required if a library project is currently cre-
ated in which a target specific library has to be referenced and this library
should not be specified yet.

[pddtibrory [
Ubrary | placeholdst |
 Company: '|(AII camparias) :l

F]

‘Library' tab dialog

£ (I‘-‘Ilsu:i:llanéuq's)
* Application  Category
ndral.ogj Name of library

SR CMLY 90110 Saen
3 RIL CheckRby 97,00 Siefeam
’@Rﬂ__.i;qmrﬁhhwpés: a5 M0 Sistem
«@8 RIL Diagnosis. 95001 Spaten
5 RIL_EtherNetlP 51,00 Spstan
i3] RIL_HMI_Ublities 1000000 Spsvan
S RTINS 9.0

I ospl

[ - T o ] conm |

Version

Fig.3-193: Add library’ dialog, ‘Library’ tab. Displays only the most recent version.
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Livary | placeholder |

Company: [[F—.ll COMDANISS)

: {Sonstige)
s= Application  Cosengy
I.ndral_u%';/’

. £ Ii
S e Name of library
10 VG _DP P

[OnCoperFidldBus - =o~ 44— Company |

o 00110 . v =
ersions
i 9:3.1.0 &

o)
SIRH (MLx
1 RIL- Ched®ty

S IRIL_CommonTypes  Spwem

R Niannnsis LI
v Group by category (¥ Display all versions (jor experts only)

Details, .. | Find... | Library Repositary, .. | OF;, I Cancel |

I—— 1 Il

always newest version

Fig.3-194: Add library’ dialog, 'Library’ tab. Displays all versions.

All installed libraries are shown here. The list can be filtered according to
company. "(All companies)" displays all available libraries).

If the Group by category option is selected, the libraries for the company that
is currently set are grouped according to the defined categories. The catego-
ry designations appear as nodes. A single click on a node opens the list of
the related libraries (Library names) or subcategories. A single click on a li-
brary name opens the list of the available versions. If the libraries are not
grouped according to categories, the list of all of the libraries is sorted alpha-
betically.

Select the desired version of the library. A "*" appears in the list in addition to
the currently installed versions of a library If the asterisk is selected instead of
a concrete version of the library, the latest version available in the repository
is always used in the project.

Select the desired library. If Display all versions (for experts only) is selected,
all of the currently installed versions of a library are listed. A "*" also appears
in the list; it stands for "Newest available version in the repository". In this
case, you can also select among the various versions. However, this option is
not selected by default. Thus, only the most recent version is displayed. In
this case, several libraries can be selected: To do this, press and hold the
<Shift> key down while selecting the desired libraries.

After confirming the selection with OK, the library version is added to the Ii-
brary manager.

The Find... button is used to find libraries containing the requested function
blocks. A search dialog opens to enter the name of the function block as well
as placeholders like "*" and "?".

To add a library that is not yet installed on the local system, use the Library
Repository button to open the dialog of the same name in order to carry out
the installation.
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'Placeholder’ tab dialog

Menu ltems

Add Library

Libraty  Placeholder l

Placehaolders are used to include target-specific libraries ta a project. The placeholder will be resalved with a
"real” library depending on information stored in the device description, If this library manager is not below a
device, the placeholder will be resolved with the library specified in the Field "Default library",

Placeholder name:  |PLCopenFieldEus_EBase j

Default librarw:

COmpany:

+=- IndraLogic ﬂ
+-: Base |
<38 [L_YCP_DP
=1l PLCopenFieldBus
=&l RIH_CMLx

28 RIL_CheckRby ﬂ

¥ Group by category [ Display all wersions (for experts onlby)

Details, .. Library Repository, .. | Cancel |

Fig.3-195: Add library’ dialog, ‘Placeholder’

Placeholder with a project

If any project is to be compatible with several exchangeable target devices,
the device-specific libraries have to be integrated into the project library man-
ager via placeholders.

As soon as a target device is specified, the placeholders are filled according
to the related device description. But even if there is currently no device de-
scription available, the placeholders already allow for a syntactic project test.

To add a library to the library manager using placeholders, it has to be selec-
ted first from the list provided in the Default library section. The selection can
be limited by specifying a company.

Apart from that, the placeholder name has to be entered in the corresponding
field. In order to simplify correct entry, all placeholder names currently de-
fined in device descriptions are provided in the selection list.

Placeholder within a library project

If a library project is based on other libraries which depend on the target de-
vice, these libraries have to be integrated into the library project by means of
placeholders.

That means, a concrete library is not integrated here, but instead, just a pla-
ceholder. Later, when <library_xy> is used for a specific device in a project,
this placeholder is replaced by the name of the device-specific library. How-
ever, this name has to be defined in the associated device description file. An
entry has to be present there that assigns the name of an existing "real" li-
brary to the placeholder name.

If, for whatever reason, no device-specific library is available, the placeholder
is replaced with the Default library entered here in this dialog. (This enables
the library project to be compiled without errors, for example, even if there is
no existing suitable device description at this point in time.)

In the Placeholder name field enter a character string as a name for the pla-
ceholder.

In addition, select one of the currently installed libraries as the Default library.
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Menu ftems This procedure is like adding a library as in the 'Library' subdialog. As in that

dialog, select the "Display all versions" (for experts only) option to display a
list of all versions of a library currently installed on the system.

After closing the dialog with OK, the "Placeholder library" is added to the "Li-
brary Manager" tree.

If the Properties dialog, page 230, is opened for this entry, information on the
assigned default library can be accessed via the "Default" field.

The placeholder has not yet been replaced in the following example; later,
when the library manager is located below a device with the corresponding
device description, the name of the device-specific library appears in the
'Name' field instead of the placeholder.

=gl mf basa mic /5 il

E| EetBO p——
= Properties - #BASELIB
=] @ethi Seneral:
=| etle
EorTit Mamespace:
|E] Getve Ciefault library:  |ML_Base_MLC_LES, 12.0,30.0(F J
=| Getve

1 = Pata T yisiblity:

Fig.3-196: Example of a library placeholder in the library manager

3.7.3 Properties...

This command is available in the Library manager, page 368, editor window
if a library entry is currently selected.

It opens the Properties dialog for the selected library and allows the following
settings with regard to namespace, version management and behavior to be
made in case the library is referenced in another library and is included in a
project via the other library:

Properties - #BASELIB
General: =i |
Namespace! ] B e A e 1 .

o~

Erefault ibrary: ]h’l]._Bcrsa_I"v‘[l.C_LEE, 2083000 () | £ M At Sl

Visibifitye:
IF the current praject 5 referenced as a library by amother project:
W Publish all IEC symbuls ta that praject as i this reference would have been included there directly.

I Hide this reference in the dependency tree.

ok | Cancel

Fig.3-197: "Properties” dialog for a library

General information:  Namespace: The current namespace for the library is displayed. By default, it
is identical with the library name, unless a different default namespace was
explicitly defined in the project information when the library was created. The
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Version:

Visibility:

Menu ltems

namespace can be modified for the local project in this "Properties" dialog at
any time.

For further information on the namespace for libraries, see page 368.

Default: If a library placeholder is currently selected in the library manager,
this field contains the name of the library that is to replace the placeholder
when the device-specific library is available.

For further information on Library placeholders, see page 229,.
Determine here which version of the library is to be used:

Specific version: Exactly this version is used. Select the desired version from
the list.

Newest version always: The newest version of the library found in the library
repository is always used. This means that the library modules actually used
can change, since a newer version of the library is available.

These settings are useful when the library is included in another library, i.e. is
referenced there. By default, these settings are not selected.

Publish all IEC symbols to that (referencing) project.... As long as this option
is not selected if library function blocks are later included in another library,
they can be uniquely addressed by using the corresponding namespace
path. This is a combination of the namespace of the "father" library and the
its own namespace and is appended to the front of the function block name
(prefix).

If, for example, the library "RIL_Ultilities" references the library
Q "Util" and "Util" contains the function block "BLINK", an instance
"bk1" of "BLINK" has to be declared as follows:

bkl: RIL_UTILITIES.UTIL.BLINK;

For further information about using libraries, see page 83.

= The option should only be selected if you wish to create a so-
called "container library", i.e. a library that does not define its own
blocks, but instead, only references other libraries to create a type
of library bundle. This can be useful for including several libraries
in a project simultaneously, by simply including the container Ii-
brary. In this case, however, itis desirable to position the individu-
al libraries in the package at the top level in the project's library
manager in order to shorten the access path for the library blocks.
And that is exactly what can be achieved by selecting these op-
tions ahead of time.

Hide this reference in the dependency tree: If this option is selected, the li-
brary is later included in another library and this library is then added to a
project, it is not be displayed in the Library Manager.

This allows "hidden" libraries to be added, but it has to be carried out con-
sciously, since errors occur during compilation that are related to errors in the
library. There might be problems finding the cause.

3.74 Reload Library

This command is available in the Library manager, page 368, editor window
if a library is selected that was not loaded correctly when the project was
opened.

If, for whatever reason, a library is not available at the defined repository path
when a project is opened, a corresponding error message is output.

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



232/697 Bosch Rexroth AG

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

Menu ltems After having corrected the error and the library is properly available again, se-
lect the command 'Reload library' for this library. This way, reload the library
without exiting the project.

3.8 Image Pool - Commands

3.8.1 Image Pool - Commands, General Information

Icon:

An image pool, page 61, is an object for managing images.

The "image pool" object is available in the "VI logic objects" folder in the "PLC
objects" library. Use drag&drop to insert it below the "Application" node or in
the global "General module" folder.

Altematively, also use Add » Image pool in the respective context menu; see
the following figure.

= E DEC_Pigject

| Gateral moduls Tolds

2] DCC_Contiol_01 Simuiation
B Library Impart, ..
i Create Library.,..
[BL Print Preview. .. -
& Frnt.. ol

Excpiort....

% Data Types,.,
[y Folder...
@ Global variable Listi

Imaage Pool. ..

= Interface...

Fig.3-198: Adding an image pool info the project

The menu structure can be reconfigured using the Customize dialog.
Commands:

®  Generate global image pool, page 232

®  Generate image pool, page 233

3.8.2 Generating a Global Image Pool

= Note that "GloballmagePool" is automatically generated in the
"General module" folder when the first use of static image files is
defined in a project.

In the main menu click on VI Logic Visualization » Generate global image
poolto create the global image pool "GloballmagePool" manually.

Alternatively, Generate global image pool is also available in the context
menu when the mouse is moved to the working area of a visualization.

image pool, page 61, contains more information on "image pools".
"GloballmagePool" is a pool of static images that are used in visualizations.
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3.8.3

3.9
3.9.1

3.9.2

3.9.3

Generating an Image Pool Menu Items

#HHt in preparation ###

Recipe Manager - Commands
Recipe Manager - Commands, General Information

Add Recipe

Add Variable

A recipe manager, an object assigned to an application, can be assigned 1..n
recipe definitions (see recipe manager, page 382).

Each of these recipe definitions is a table, the columns of which are "recipes”
and the lines of which are "variables".

If a new recipe definition is assigned to the recipe manager, its initial set of
columns comes from the recipe manager.

The following recipe manager commands are used to insert additional col-
umns or delete columns or to insert new variables or delete variables.

The commands are available in the context menu when a recipe definition is
being processed in the editor. In the basic configuration they are also availa-
ble in the VI Logic recipe definition main menu.

If necessary, the menu structure can be modified in the dialog under
IndraWorks » Tools » Customize » Commands > Recipe Manager.

Commands.:

®  Add recipe, page 233

®  Add variable, page 233

® Remove variable, page 234
®  Remove recipe, page 234

Icon: -I'}\a.

This command is used to add a new column for a recipe, page 384 to the
recipe definition currently being processed.

Click on VI Logic recipe definition » Add recipeto add a new recipe.
Alternatively, the command is also available in the context menu.

The "New Recipe" dialog opens to enter a name for the recipe; see the fol-
lowing figure.

Marne: IEqumn
Ok I Cancel |

Fig.3-199: New recipe dialog

= A new recipe can also be created in online mode using a corre-
spondingly configured visualization element; see "Visualization el-
ements - Properties", page 451.

Icon: "?
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Menu ftems Use "Add variable" to add a new line for a variable entry at the end of the rec-

ipe definition that is currently open.

Enter the desired variable in the Variable column; see also recipe definition,
page 384.

Click on VI Logic recipe definition » Add variableto add a new variable. Alter-
natively, the command is also available in the context menu.

3.9.4 Remove Recipe
3

lcon: =4

"Remove recipe" is used to delete a recipe from the currently open recipe
definition, see also "recipe definition", page 384.

Select one of the fields in the recipe column and click on VI Logic recipe defi-
nition » Remove recipeto remove a recipe. Alternatively, the command is also
available in the context menu. The column is removed.

= Recipes can also be deleted in online mode using a correspond-
ingly configured visualization element; see "Visualization ele-
ments - Properties", page 451.

3.9.5 Remove Variables

Icon: T

Use "Remove variable" to delete one or more variables from the currently
open recipe definition, see also "recipe definition", page 384.

Highlight one of the fields in the line that describes the variable or highlight
several lines while holding down the <Ctrl> key and click on VI Logic recipe
definition » Remove variableto remove variables.

Altematively, the command is also available in the context menu. All selected
lines are removed.

3.10 Object Management - Commands
3.10.1  Object Management - Commands, General Information

The commands for managing objects in a project are described in this sec-
tion. By default, these commands are included in the context menu of the rel-
evant object, suitable for the object.

The commands.

®  Add object, page 234

e  Edit object, page 236

®  Set active application, page 237.

3.10.2 Adding an Object

This command provides access to the existing object types.

The only object types listed are those that can be inserted at the current posi-
tion in the Project Explorer.

For example, a data server object can only be inserted if "Application" is se-
lected in the Project Explorer or an action can only be inserted if a function
block or program is currently selected.
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:

Interface, .,
Data Server..

Data Types...

Global Yariable List...
PoUsfor npick Check..
Trace...

Text List...

visualization Managet. ..

wisualization...

Glohal Network Vanable List..,

Global Persistent Variable tist:

Fig.3-200: Adding an object
Select the desired object type using the respective context menu and in the
following "Add object" dialog, define the Name and the respective settings for
the object.

Please note the Recommendations for names, page 505 to achieve a certain
amount of consistency.

The settings that need to be made depend on the object type.

For more information, see the help pages for object type or the corresponding
editor:

Action, page 51

Application, page 66

Library manager, page 367
Image pool, page 61

Data source, page 318

Data server, page 71,

DUT, page 43

Property, page 46

Device, page 63

Global variables list, page 367
Method, page 45

Persistent variables, page 54
POU, page 28

POUs for implicit checks, page 63,
Recipe definition, page 384
Recipe manager, page 382
Interface, page 49

Step, page 405,

Symbol configuration, page 306
Task configuration, page 423
Task, page 428




